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CREATING A PRINTED 
CIRCUIT BOARD 

(PCB) 
 
 
 
 

Using TINACloud, you’ve captured the schematic of your circuit and refined the design. 
It’s time to make a prototype of the circuit or to manufacture it. It’s good to know that 
you can continue the process still using TINACloud, since PCB design is now an 
integral part of the program. 
 
Let’s learn how to design a PCB by working through a few examples. 
 
Note that the different phases of the presented design examples have been saved in 
the TINA’Clouds Examples/PCB directory using the following naming conventions: 

 
* origin.tsc original schematic file 
*.tsc backannotated schematic file (after pin/gate swapping)renumbering) 
* placed.tpc design parameters set, components placed pcb file 
* routed.tpc net properties set and routed pcb file 
* finished.tpc optionally  pin/gate  swapped  and  renumbered,  routed,  silkscreen  adjusted, 

documentation layers finalized pcb file 
 

If you save your versions of these demo examples, be careful not to overwrite the 
original files TINACloud installed. 

 
1.1 Setting and checking footprint names 
 

As  a  first  example,  open  the  opamp2.tsc  project  from  TINACloud’s  
Examples/PCB folder. The following schematic will appear: 
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To achieve an accurate PCB design, one that is easy to build, every part in your 
schematic must have a  physical  representation with  exact  physical  size.  This  is  
realized  through so-called footprints: drawings showing the outline and the pins of the 
parts. 
The footprint naming convention in TINAC l o u d  uses as a  starting point the IPC-
SM-782A (Surface Mount Design and Land Pattern Standard)  and  the  JEDEC  
standard JESD30C  (Descriptive Designation System for Semiconductor-Device 
Packages, see http://www.jedec.org/download/search/jesd30c.pdf.). However, the 
libraries do not conform t o any given set of industry or manufacturer standards 
because standards have difficulty keeping up to date when technology changes faster 
than the standards. Generally,  standards  mirror  a  fixed  set  of  data  at  a   point   
in   time,  while new manufacturing capabilities lead to ever-smaller new footprints with 
more and more pins. 
 
We  have  already  assigned  default  footprint  names  to  all  parts  that  represent  
real components. 
 
Note that some parts used for theoretical investigations, controlled sources, for example, 
do not represent real physical parts and cannot be placed on a PCB. If your design 
contains such components, you should replace them with real physical parts. 
 
Of course there is no guarantee that the default physical packages of TINACloud’s 
parts are the same as needed by your design. 
 
There are two ways to check this. 
 
1) You  can  use  TINACloud’s “Footprint name  editor”, which  you  can  invoke  
from TINACloud’s Tools   menu.   In   this   dialog   you   can see all   of   
TINACloud’s components and their corresponding footprint names. 

http://www.jedec.org/download/search/jesd30c.pdf.)
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Select from the available footprint names by clicking on the footprint name fields. In 
the dialog box, components with no footprint name association are denoted by empty 
footprint name field. 

 

 
 
 

2) The second way to examine the assigned footprints is to double-click on each 
part and check the Footprint Name in the component property dialog that appears.
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1.2  Invoking TINACloud PCB 
 

To begin PCB design , press the    button on TINACloud’s toolbar (the last 
one on the right) or select the “PCB Design” command on the Tools menu. Set the 
parameters as shown below. 

 
 

 
Select “Start  New  Project,”  “Autoplacement,”  and  “Use  board  template.”  With 
the Browse button find  and  select the  2layer_A.tpt template file  from  
TINACloud’s Template folder. Using this file will ensure the proper settings for a 
double-sided PCB. 
 
When starting with a TINACloud template, you are choosing the level of manufacturing 
complexity of your project. The following three levels of manufacturing technology 
are defined by the IPC-2221 generic standard: 

 
Level A : General Design Complexity  
Level B : Moderate Design Complexity  
Level C : High Design Complexity
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The template file specifies the number of layers, including their properties, system 
grid size, autorouter settings, spacing and track width. The following templates are 
included with PCB Designer: 

 
 Level Routing 

Layers 
Plane 
Layers 

Routing Spacing Comments 

1layer_A.tpt A 1 - 25 12 1/2 Allows one track between 
standard IP IC pin 2layer_A.tpt A 2 - 25 12 ½ 

2layer_B.tpt B 2 - 8 1/3 8 1/3 Use  for  SMT  or  mixed- 
technoly board 2layer_B_mm.tpt B 2 - 0.1 0.2 

4layer_C_mm.tpt C 2 2 0.1 0.15 For  moderate  and  high 
density 

 
In choosing a PCB template, you should take into consideration technology, density, and 
package pitch. 
 
To complete the set up, set the PCB size in inches or mm depending on the 
measurement unit settings in the View/Options dialog of TINACloud. 
 
Now that everything is set properly press the OK button and the PCB layout design 
will appear with all the components automatically placed on the PCB board. 

 

 
 

While  all  the  parts  and  nets  are  placed,  we  need  to  adjust  their  positions  for  
good placement and easier routing. Click and drag the parts to the position as shown 
on the figure below. (Find “opamp2 placed.tpc” to check your results.) 
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Click on Tools main menu item to reach the Net Editor and set net routing width. 
First, enter 12.5 into a “Track width” field then press “Set All”. Then select power 
nets (Ground, VCC, -VCC) and set their track width to 25mil. 
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To  automatically  route  the  PCB, press  select  “Autoroute board” command from the 
Tools menu. The following screen will appear: 

 

 
 

To see of everything is route  correctly  select  DRC  (Design Rule Check)/Run DRC 
from the Tools menu. The following message will appear: 

 

 
 

To finish our first simple design, let’s add text to the silkscreen/assembly layer. Click 
the Text button on the toolbar and make the settings in the dialog that appears: 
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Enter the text into the empty upper field and press the OK button. The text will 
be attached to the cursor. Move it to the location shown on the picture below. 

 

 
 

Finally, you can check your design in full 3D. Press the 3D View button on the toolbar’s 
right end or select “3D View” from the View menu. The following window will appear. 
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You can rotate the 3D model to any direction by ho ld ing  the  l e f t  mouse  
bu t ton  and  mov ing .  Hold down the middle button and move the mouse to 
shift the viewpoint. You can also move the ”camera” forward or backward to set a 
large view showing the complete PCB or to zoom in for more details. Use the mouse 
wheel for this operation. 
At this point, you will probably want to create Gerber files for a manufacturer.  
 
To obtain Gerber (RS - 274 X  format)  files to direct a photoplotter, choose 
ExportGerber file from the  File menu. (Various Gerber options can be changed 
using the dialog for Gerber output settings under the Options menu.) 

 
 

1.3   Advanced editing functions of TINACloud PCB’s  
 Layout editor 
 

In practice, you may need to do  s ome  editing using TINACloud  PCB’s advanced 
editing features. This is described through examples in the next section.
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CREATING A TWO-LAYER, 
DOUBLE-SIDED, 

SURFACE-MOUNT 
TECHNOLOGY BOARD 

 
 
 
 
To get into TINACloud in more detail, open the second example, the file PIC flasher 
origin.TSC project from TINACloud’s Examples/PCB folder.  

 

 
 

The schematic is PCB-ready, every part has a surface mount device (SMD) physical 
representation. Now, before we start the PCB wizard, click Tools/Footprint Name 
Editor… to check the footprints list. 
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Since all the components appear to have a valid footprint name, we can start using the 
Tools/PCB Wizard.  C l i ck  on  “PCB Des ign . . . ”  i n  the  Too l s  menu  o r  on  

the   bu t ton  on  TINACloud ’ s  too lba r .  
Set  the  “Start  new  project,”  check  “Autoplacement”  and “Use board template.” 
Select the template file “2layer_B_mm.tpt.” 
 
Review actual physical parts, if possible. Be sure to allow for the area of all the 
components, mounting holes, and keep-away zones and make your best estimate of the 
values for  Board  width  and  Board  height.  Moreover, it  is  important   to  provide 
enough  space  between  the  components  to allow for  the placement of vias and tracks 
during routing. Enter 40mm length and 30mm width. 

 

 
 

Press the OK button, the PCB Editor window will appear. 
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The components are placed in the close proximity to minimize the connection lengths, in 
a topology similar to that of the schematic, while still respecting the design rule settings. 
However convenient the result may be for autorouting, the designer usually has to make 
adjustments to the   component   layout   to   satisfy   electrical,   mechanical and other 
characteristics. Some of the considerations are–– 
 
•  the ohmic effect of a long and/or thin power trace the  length  of   a  track  from 
 the signal source to the load  in high-speed digital systems introduces reflections 
•  in  analog  situations,  poor placement can lead to increased noise coupling 
•  allowance for automated parts placement clearance 
•  future serviceability of the PCB 
•  aesthetic values 
 
These considerations influence the components’ position and could be critical–not only in 
complex designs–but even  in  the  simplest  ones. For these reasons, one must still adjust 
parts placement manually. 
Our circuit, although it is small and not very dense, has  a  f e w  special 
requirements, namely to put the crystal closer to the microcontroller, t o  position the 
power supply connector, and to adjust the LEDs along the board. 
If you want to change  the  board  size, click t h e  “Draw/modify shapes”  button . 
Let’s try making the board smaller. You can double click on the middle of the board and 
enter the following values into the fields: 
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When you press OK, the board outline will shrink. 
Now, before we begin routing, let’s set the position of the components; place the power 
connector and the DIP switch on the left hand  side  and  the  LED  bar  on  the  right hand  
side. Place the capacitors and  resistor networks on  the  bottom side  by  double clicking on 
the components and choosing Bottom Placement side on the dialog. 

 

 
 

Compare your result to the file \Examples\PCB\PIC flasher placed.tpc.
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In order to decrease route length, swap R1 pins connected to SW1. Pin swapping is 
allowable if identically functioning pins are to be exchanged, such as pins of resistors, 
capacitors, etc. Click on the Pinswap button  on the toolbar to pick up the tool, click 
on  pad 1 of R1 (the upper right), and–finally–pad 4 of R1. The following window should 
come up: 

 

 
 

Press the Yes button, then do the same with R1 pad 2,3 and R2 pad 3,4. 
Note that a pin swap changes the original connections, so we must update the original 
schematic later to maintain the correspondence between the schematic and the board taking into 
account the changes we  made  to  the  board  while using PCB  Designer.   
This process, called back annotation, has to be completed whenever a pin/gate swap 
and/or component renaming have been performed. 
 
Signal planes (in our present example, the top and bottom layers) generally are given 
preferred trace directions up and down in one layer and left and right in the other layer. 
To set these  t race  d i rect ions ,  click on  Options/Autorouter settings.  The 
Autorouter settings are set to our preferred direction by choosing an integer number 
from 1 to 9. A value of 1 forces the router to heavily emphasize horizontal lines, while 
a value of 9 forces it to use vertical lines. 5 tells the router not to care about 
horizontal or vertical preference. Choosing the extreme values (1 and 9 for a pair) is 
usually too strict, so we choose to enter 3 for the top layer and 7 for the bottom.
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Also on this panel, check “Force router to use short side SMD pad entry” with pad 
number 9 constraining the router to connect SMD pads on their short side if the 
component has at least 9 pins. This option can be very used to preserve the gaps 
between SMD pads for track routing. Because of these choices, R1, R2 and SW1 are 
allowed to route freely, as half of the pins are connected together, while U1 pads connect 
on the short side. 
 
After these moves, click on the main menu Tools/Autoroute board to route the PCB 
automatically. First  the  power  and  ground  nets  are connected,  then  signals are  
routed.  If necessary,  the  program  wi l l  rip-up  tracks  and  reroute  the  unconnected  
nets.  The following result will appear: 
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In some cases you might see that there is a net left unconnected.  Fortunately, the DRC 
utility will examine your design and reveal any unconnected traces. Run DRC by clicking 
on the menu Tools/DRC/Run DRC. 
The DRC Results window will appear, highlighting the corresponding nets. 

 

 
 

You should browse and correct any errors DRC reports. If you double click on the text 
‘Unrouted net N00013,’ the program magnifies and highlights the selected net while 
centering the position of the selected objects. 

 
 

In order to fully route the board, we can use the manual route modes to make space for 
the unconnected tracks or delete crossing tracks and reroute them in a different order. 
Working in manual route, you can direct routing wherever necessary. You can move 
existing segments of tracks, remove segments, or create new segments. 
 
Proceeding step by step, we will use autorouting to route the last trace. 
 
First, press the , the select button on the toolbar, then hold down the Shift key and 
click the track that connects U1 pad 9 to D5 (see picture below), then press the Delete 
key to remove the track. This makes room for the unconnected net. 
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Now  c l i c k  o n  t h e  m e n u  T o o l s / N e t  e d i t o r  to invoke the net  editor. 
Disable  N00012,  the  previously  removed connection. This will prevent the 
autorouter from reconnecting the net. Leave N00013 routing enabled. 

 

 
 

Click OK and the menu Tools/Continue autorouting and the autorouter will connect all 
the enabled nets. Next, enable N00012 in the Net editor, checking Routing Enabled, 
clicking OK and click again on Continue autorouting menu to autoroutethe last net. 
 
Let’s see if our manual intervention has worked. Call again Run DRC to verify that there 
are no errors. 
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Now, let’s synchronize the PCB and schematic files. First, choose TinaCloud 
backannotation from the File menu to save the changes back to the schematic Editor.  I n  
t h e  o t h e r  b r o w s e r  w i n d o w  TINACloud will read and update the original 
schematic. 
Take  a  close  look  at  the  resistor  networks–the  pin  order  reflects  the  result  of  
the pinswap. 
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